Excel 2016: Basics 2
Math and Functions
Excel 2016: Basics 2 - Math and Functions
2.0 hours

In this workshop we will work with patterns of text, numbers and dates; build simple equations; use basic mathematical functions such as SUM( ) and AVERAGE( ); learn about absolute and relative references, naming cells, and working with named cell ranges. This basic workshop assumes some experience with Microsoft Excel.

Fill Handle.......................... 1
Fill Handle Options.......................... 2
Mathematical Operations.......................... 2
Building an Equation.......................... 3
  Type in the exact cell address.......................... 3
  Use the keyboard to point to the cell address.......................... 3
  Use the mouse to point to the cell address.......................... 3
Order of Operations.......................... 4
Formatting Dates.......................... 4
Formula View.......................... 5
Absolute/Relative.......................... 6
Functions.......................... 7
Naming Cells.......................... 9
Class Exercise.......................... 10

Pandora Rose Cowart
Education/Training Specialist
UF Health IT Training

C3-013 Communicore (352) 273-5051
PO Box 100152 prcowart@ufl.edu
Gainesville, FL 32610-0152 http://training.health.ufl.edu

Updated: 2/15/2019
**Fill Handle**

The **Fill Handle** is in the bottom right corner of the selected cell. When you place your mouse over this handle, it changes from a thick white cross, to a thin black cross. Once you see the thin cross (no arrows) you can click and drag the cell to fill its contents in a single direction (up, down, left or right). If you want to go in two directions, you must first complete one way, let go of the mouse and then drag the handle in the second direction.

When you use the **Fill Handle** to pull down a single number or plain text, it will copy the data.

![Image of Fill Handle]

When you use the **Fill Handle** to pull down a text with numbers, a date, a month or a weekday it will fill in a series.

<table>
<thead>
<tr>
<th>Exam 1</th>
<th>2/1/02</th>
<th>February</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exam 2</td>
<td>2/2/02</td>
<td>March</td>
<td>Saturday</td>
</tr>
<tr>
<td>Exam 3</td>
<td>2/3/02</td>
<td>April</td>
<td>Sunday</td>
</tr>
</tbody>
</table>

When you select two or more numbers (including dates) and then use the **Fill Handle**, Excel will fill in the series, following the original pattern of the selected cells. It can only follow simple addition and subtraction patterns.

<table>
<thead>
<tr>
<th>123</th>
<th>5</th>
<th>100</th>
<th>2/01/02</th>
</tr>
</thead>
<tbody>
<tr>
<td>124</td>
<td>4</td>
<td>110</td>
<td>2/08/02</td>
</tr>
<tr>
<td>125</td>
<td>3</td>
<td>120</td>
<td>2/15/02</td>
</tr>
<tr>
<td>126</td>
<td>2</td>
<td>130</td>
<td>2/22/02</td>
</tr>
</tbody>
</table>

The **Fill Handle** will follow the format of the original cells. This includes number formats as well as capitalization,

<table>
<thead>
<tr>
<th>Friday</th>
<th>FRIDAY</th>
<th>fri</th>
<th>$123.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saturday</td>
<td>SATURDAY</td>
<td>sat</td>
<td>$123.00</td>
</tr>
<tr>
<td>Sunday</td>
<td>SUNDAY</td>
<td>sun</td>
<td>$123.00</td>
</tr>
</tbody>
</table>

If you double-click on the Fill Handle it will 'fill' as many cells as the previous column has in use.
**Fill Handle Options**

When you use the **Fill Handle**, you will notice a symbol appear in the right hand bottom corner of your newly filled cells. This icon (กระบอง) represents your AutoFill Options. If you put your mouse over the icon you will see a drop down arrow that will give you a list of your fill options.

The four basic Fill Options are:
- Copy Cells – Repeat the cells along the selection
- Fill Series – Follow pattern along the selection
- Fill Format Only – Repeat the format of the cells along the selection
- Fill without Formatting – Follow the pattern along the selection, but not the format
- Flash Fill – Fills based on a pattern you establish in the same column

If you use the **Fill Handle** on cells with dates you will notice even more options:
- Fill Days
- Fill Weekdays
- Fill Months
- Fill Years

**Number Fill Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Cells</td>
<td>=5+2</td>
<td>7</td>
</tr>
<tr>
<td>Fill Series</td>
<td>=5-2</td>
<td>3</td>
</tr>
<tr>
<td>Fill Formatting Only</td>
<td>=5-5</td>
<td>-5</td>
</tr>
<tr>
<td>Fill Without Formatting</td>
<td>=5*2</td>
<td>10</td>
</tr>
<tr>
<td>Flash Fill</td>
<td>=5/2</td>
<td>2.5</td>
</tr>
<tr>
<td></td>
<td>=5^2</td>
<td>25</td>
</tr>
</tbody>
</table>

**Date Fill Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Formula</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill Days</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill Weekdays</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill Months</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill Years</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Mathematical Operations**

To let Excel know you expect it to "do math" you need start your cell with an equal sign (=).

- Addition, plus sign (+) = 5+2 result 7
- Subtraction, hyphen (-) = 5-2 result 3
- (also used for negative) = -5 result -5
- Multiplication, asterisk (*) = 5*2 result 10
- Division, slash (/) = 5/2 result 2.5
- Exponent/Power, caret (^) = 5^2 result 25

There are several operands to use for logic comparisons.

- Greater than, greater than sign (>)=5>2 result TRUE
- Less than, less than sign (<)=5<2 result FALSE
- Equal to, equal sign (=)=5=2 result FALSE
- Not equal to, both greater and less than signs (<>)=5<>2 result TRUE
**Building an Equation**

You can directly type in values, but that data stays constant. If you want to have the answers to your equations update as you change your data, you should use the cell addresses. You will see the cell addresses change colors so you can tell which ones are used in your equation.

**Type in the exact cell address**

Cells are labeled by their row and column headings. Rows are numbered and go horizontally across (rows of chairs) and columns are lettered and go vertically top to bottom (columns of a building). When we refer to the address of a cell, we use the column letter then the row number such as A1.

- Click in the cell where the answer will appear
- Press the Equal sign (=)
- Type in the cell address you want to use in your equation
- Accept the answer or press the next math operator (+, -, *, /, ^)

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>=a1+b1</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Use the keyboard to point to the cell address**

When you first enter a character into a cell, you will be in "ENTER" mode. This includes when you type an equal sign. But if you press an arrow key on the keyboard after the equal sign, Excel does not move out of the cell. Instead you will be put into a "POINT" mode, and Excel will color coordinate the cell you are selecting.

- Click in the cell where the answer will appear
- Press the Equal sign (=)
- Press the arrow keys until you are on the cell you want to use in your equation
- Accept the answer or press the next math operator (+, -, *, /, ^)

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>=A1</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Use the mouse to point to the cell address**

The mouse and arrow keys are both "pointers". If you press the equal sign and then use the mouse to click on another cell, Excel will put you into a "POINT" mode, and place the address of the cell you clicked on in your equation.

- Click in the cell where the answer will appear
- Press the Equal sign (=)
- Use the mouse to click on the cell you want to use in your equation
- Accept the answer or press the next math operator (+, -, *, /, ^)
Order of Operations

Microsoft Excel respects the Order of Operations.

1. Parenthesis
2. Exponents (raised to a power)
3. Multiplication and Division
4. Addition and Subtraction

<table>
<thead>
<tr>
<th>Parentheses</th>
<th>Exponents</th>
<th>Multiply</th>
<th>Divide</th>
<th>Add</th>
<th>Subtract</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please</td>
<td>Excuse</td>
<td>My</td>
<td>Dear</td>
<td>Aunt</td>
<td>Sally</td>
</tr>
</tbody>
</table>

This means with an equation such as

\[= 5 + 3 \times 2\]

Excel will do the multiplication before it does the addition. The result would be 11.

If you wanted the addition to happen first, you have to use parentheses:

\[= (5 + 3) \times 2\]

giving us a result of 16.

In math, we use the brackets, such as

\[
(((5+3)\times(4-2))/2)
\]

In Excel we ONLY use parentheses

\[=((5+3)\times(4-2))/2\]

result 8.

Formatting Dates

Dates and Times are technically numbers because they can be used in equations. Excel is able to do this because it has a "serial" number equivalent. Both columns of this table at the right of this page show the same value, but the dates in the second column have lost the date format. For a date, 0 = 1/1/1900. The numeric values in the second column represent how many days there are between 1/1/1900 and the date listed.

If your date loses its format you can modify it through the Number group or through the Format Cells Window. If you don't like the choices offered, you can custom build your date from the Custom section of the Number page in the Format Cells Window. Use M for months, D for days and Y for years. Excel is not case sensitive, upper or lowercase letters will work for these formats.

<table>
<thead>
<tr>
<th>Date</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/16/1978</td>
<td>28,810.00</td>
</tr>
<tr>
<td>5/2/1982</td>
<td>30,073.00</td>
</tr>
<tr>
<td>11/4/1986</td>
<td>31,720.00</td>
</tr>
<tr>
<td>2/23/1993</td>
<td>34,023.00</td>
</tr>
<tr>
<td>11/13/1995</td>
<td>35,016.00</td>
</tr>
<tr>
<td>2/2/2002</td>
<td>37,289.00</td>
</tr>
<tr>
<td>7/24/2008</td>
<td>39,653.00</td>
</tr>
<tr>
<td>12/25/2010</td>
<td>40,537.00</td>
</tr>
<tr>
<td>6/8/2013</td>
<td>41,433.00</td>
</tr>
<tr>
<td>11/20/2018</td>
<td>43,424.00</td>
</tr>
</tbody>
</table>

Remember to let Excel know you want it to calculate something; you have to start with an equal sign (=).

If you get stuck inside an equation, or confused by a mistake, press Esc to cancel and try again.

Friday, February 1, 2002

dddd, mmmm d, yyyy

<table>
<thead>
<tr>
<th>Day</th>
<th>Month</th>
<th>Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>m</td>
<td>y</td>
</tr>
<tr>
<td>dd</td>
<td>mm</td>
<td>yy</td>
</tr>
<tr>
<td>ddd</td>
<td>mmm</td>
<td>yyyy</td>
</tr>
<tr>
<td>dddd</td>
<td>mmmm</td>
<td>yyyy</td>
</tr>
</tbody>
</table>

You can also custom build times using H for hours, M for minutes and S for seconds.
Formula View

Our cells display the formula results. If we want to see the equation, we have to look at the formula bar or edit the cell. Sometimes it helps to see all the equations on a worksheet. The button for this option is on the Formula tab, in the Format Auditing group. The keyboard shortcut is Control-Tilde, ctrl ~ (the wavy line above Tab, below Esc on your keyboard).

You can also turn this on through the Excel Options. From the File Menu, choose Options. On the Advanced tab, under the Display Options for this Worksheet group, check the box next to Show formulas in cell instead of their calculated results.

Calculated Results (normal view)

<p>| | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td>I</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>1</td>
<td>Big City Store</td>
<td>Date:</td>
<td>10/8/2016</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sales Report</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Items</td>
<td>Price</td>
<td>Qty</td>
<td>SubTotal</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>AAA</td>
<td>$ 123.00</td>
<td>987</td>
<td>$ 121,401.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>BB</td>
<td>$ 456.00</td>
<td>654</td>
<td>$ 298,224.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>C</td>
<td>$ 789.00</td>
<td>321</td>
<td>$ 253,269.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td>$ 672,894.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Formula View

The formula view will stretch out the columns and all the numbers appear to have lost their format, including the dates and some alignments. Be careful adjusting the column widths, if you shrink them in the formula view, it will proportionally shrink in the calculated results view.

You can continue working in this view and print out the sheet with all the formulas showing. If you’re going to print this view, I recommend turning on the print headings from the Page Layout tab.
Absolute/Relative

When you create an equation in Excel using cell addresses, Excel sets up the equation to have a relative reference. When you are using the Fill Handle or the Copy and Paste features, the equation result is relative to the location of the data. For example:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>6</td>
<td>=A1+B1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>12</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If this equation is copied into cell C2, or the Fill Handle is used to drag the equation down to C2, Excel will give you this result:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>6</td>
<td>=A1+B1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>12</td>
<td>4</td>
<td>=A2+B2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Since the equation was moved down, between rows, only the row number changes. If instead, we moved the equation across, the row numbers will remain the same, but the column numbers will change:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>6</td>
<td>=A1+B1</td>
<td>=B1+C1</td>
</tr>
<tr>
<td>2</td>
<td>12</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The addresses in the equation are relative to where the answer is positioned. The equation in cell C1 of the table above states ‘take the value of the cell that is two to the left from this cell and add it to the value of the cell that is one to the left from this cell’. When we fill or copy the cell over or down, the basic equation stays the same.

If you do not want a number to move relatively, you can make it absolute by using dollar signs ($) in the equation. The F4 button on the keyboard will place the dollar sign characters in for you while you are in Enter, Edit, or Point mode. (Think F4 -> FORCE)

- $A$1 - Locks the reference into Cell A1
- $A1$ - Locks the reference into Column A, but will allow the row number to change
- $A$1 - Locks the reference into Row 1, but will allow the row number to change
Functions
Microsoft Excel has several built in functions. To insert a function, click the **Insert Function** button on the Formula Bar, or the **Insert Function** option from the **Formulas Tab**.

From here you can request a function to perform a particular task and Excel will make suggestions for you. If you **Search for a function**: Excel will return a **Recommended** category, offering all the functions it thinks might help in your search.

By default, the first category is a list of **Most Recently Used** functions. To see all the functions built into Excel, you can choose **All** from the **Select a category**: list.

The bottom of this window displays a description of the selected function. Each choice will show an example arrangement of the function, the arguments, and a description of what that function should do. If you need more information, click on the **Help on this function** option in the bottom left corner. If you have found the function you would like to use, select it and click **OK**.

An easier way to access the list of **Most Recently Used** functions is to press the equal sign on the keyboard, as if you were going to type an equation. The name box, that displays which cell you are in, changes to the last function that was used. When you click on the arrow next to the listed function (in this case SUM), you will see a list of list of **Most Recently Used** functions.

If the function you desire is not on the **Most Recently Used** list, chose the **More Functions…** option at the bottom of the list and you will get the above **Insert Function** dialog box.
Either selection method will open the Function Arguments window.

The function name is listed in the top left corner and the description is across the bottom. There are blanks in the middle of the screen for the arguments of the statement. You can type in the cell addresses, move the window out of the way to try to select the addresses or let Excel help you move the window by using the Collapse or "go out and get it button" ( ). This button will collapse your Function Arguments window so you can select the data you wish to use as an argument in this function. Once you have chosen your desired data either press Enter or click on the Expand button ( ) to return to the full window.

In the sample above, you can see we can Sum more than one number/set of numbers. As soon as you click into Number 2 a Number 3 will appear. The description tells us this will allow up to 255 arguments (number ranges) to sum.

Across the bottom of this window we can see a Formula Result =. This will show us the running total as we add in each part of the equation. Notice there is also an =number at the end of each argument line. This will give you a piece-by-piece result for each argument. This is especially helpful when using the logic functions, such as If.

When you click the OK button, the answer to the equation should be displayed in the original cell. Double-clicking on the cell or pressing the F2 key on the keyboard will put this formula into edit mode. Excel color-codes which cells it is using in this formula. To bring back the gray edit box, click on the function button ( ) on the formula bar.
Naming Cells
Another way to ensure an absolute reference to a cell is to Name the cell, and use that name in your equation. The simplest way to define a cell name is to select the cell, erase the cell address within the name box, type the Name of the cell in the name box and press Enter.

Once a name is defined, you can use it in your equations.

\[=B12*\$B\$1\] means the same as \[=B12*\text{FixedValue}\]

When you use the fill handle or the Copy/Paste feature, the B12 will change to be relative to the new location, but FixedValue will remain throughout, always pointing to cell B1.

This same method can be used for a range of cells. Select the desired range, click within the name box, erase the current cell address, type the name of the range, press Enter.

*NOTE* There are some limitations in naming. You cannot use many special characters such as the hyphen (-), and the name must be all one word, no spaces. In the example above, we used capitalization to show multiple words, you can also use the underscore character (_).

**Good Names:** fixedvalue FixedValue Fixed_Value

**Bad Names:** fixed value Fixed Value Fixed-Value

Defined Names group on the Formula Tab:
- **Define a Name** – create a new name
- **Use in Formula** – choose from a list of existing names, this can be used to begin a new formula or to add a name to a formula you are building.
- **Create from Selection** – make a new name based on a group of selected cells.

Use the **Name Manager** to modify a Defined Name.

- **New:** Create a new Name
- **Edit…:** Rename, add a comment, change cell reference
- **Delete:** Select the name in the list and click Delete to remove it
- **Filter:** Filter the list of names to help you find the one you need.

To **Redefine:** Select the name in the list, erase the Refers to blank and choose your new range of cells. Click the Check to accept.

**F3** is the keyboard shortcut to let you pick a name to use in your equation.
Class Exercise

Review
- Open Excel
- Click on Blank Workbook
- Zoom to 150%
- Remember Text on left, Numbers on the right
- Remember to "accept data"
  - In Cell A1 type: 1
    - Press Ctrl Enter to accept (stays on cell)
  - Clear A1
  - In Cell A1 type: 1
    - Click on Check next to formula bar to accept
    - (The X is the same as cancel)

Fill Handle (pg 1)
- In Cell A1 type: 1 ("accept data" for each of these)
  - Use the Fill Handle in the bottom right corner to drag down to row 8
    - 1,1,1,1...
- In Cell B1 type: text
  - Fill to row 8
    - text, text, text, text...
- In Cell C1 type: text1
  - Fill to row 8
    - text1, text2, text3, text4...
- In Cell D1 type: 1, In Cell D2 type: 2
  - Select both and Fill to row 8
    - 1, 2, 3, 4...
- In Cell E1 type: 2, In Cell E2 type: 4
  - Select both and Fill to row 8
    - 2, 4, 6, 8...
- In Cell F1 type: 5, In Cell F2 type: 4
  - Select both and Fill to row 8
    - 5, 4, 3, 2...
- In Cell G1 type: text 1
  - Double-click on fill handle
    - text1, text2, text3, text4...
Special Reserved Words
Type the following into the cells listed and Fill using the double-click, or drag, down to row 8.
- In Cell H1 type: Quarter 1
- In Cell I1 type: 1st Qtr
- In Cell J1 type: 1st
- In Cell K1 type: 1 st
- In Cell L1 type: January
- In Cell M1 type: FEB
- In Cell N1 type: Monday
- In Cell O1 type: sat

Working with Dates (pg 2)
Type the following into the cells listed and Fill using the double-click, or drag, down to row 8.
- In Cell P1 type: 10/20
- In Cell Q1 type: 12/28/2016
  - Click on the Fill handle options, the box that pops up near the fill handle when you let go of the mouse. Try these settings:
    - Weekdays, Months, Years
- In Cell R1 type: Enter the two paydays (example: 10/14, 10/28)
  - remember to select BOTH cells before you fill

Sheet 2
- Click on the Plus sign next to Sheet 1 to create Sheet 2
- Zoom 150%
- Create data set
  - A1: 1; B1: 2
  - A2: 2, B2: 4
  - Select all four cells and fill to Row 10

Creating Equations with constant values (pg 3)
- In Cell C1 type: 1+2
  - Accept. Notice the "1+2" is on the left side of the cell meaning Excel sees "text"
- Clear the contents of cell C1 (Delete)
- In Cell C1 type: =1+2
  - Using the = sign as the first character tells Excel we are building an equation, we’re doing math. We see a 3 in the cell, but the formula bar displays =1+2
  - 1+2 always equal 3, but if we change data we want our answer to change
Creating Equations with Cell addresses (pg 3)
- Clear cell C1, type =a1+b1
  - Not case sensitive
  - Notice the color coding
  - Accept data, should get a 3
  - Change A1 to 5, accept to see answer in C1 change

- USING KEYBOARD
  - Go to C2
  - press = sign
  - press ← arrow two times
  - press + sign
  - press ← arrow once
  - enter to accept

- USING MOUSE
  - Go to C3
  - press = sign
  - click on cell A3
  - press the + sign
  - click on cell B3
  - click on check to accept

Basic math symbols (pg 3)
- Add +, Subtract -, Multiply *, Divide /
  - All found on the NumPad

- Build these equations
  - In Cell C4 add A4 and B4: =A4+B4
  - In Cell C5 subtract A5 and B5: =A5-B5
  - In Cell C6 multiply A6 and B6: =A6*B6
  - In Cell C7 divide A7 and B7: =A7/B7

Remember the Order of Operations (pg 4)
- Parenthesis
- Exponents/Powers
- Multiplication/Division
- Addition/Subtractions

- Build these equations
  - In Cell C8 type =2+3*5
  - In Cell C9 type =(2+3)*5
Date not Math?
- Put today's date in cell C10
  - i.e. 10/5
  - Note Excel sees it as a date not as an equation (10 divided by 5), Why? Because there is no Equal sign! 10/5 is October 5\textsuperscript{th}, =10/5 is an equation with a result of 2

Totals Preview
- Select Column A
- Look in the status bar in the bottom right side of the window. When you select more than one cell, Excel will automatically calculate the Average, Count, and Sum of your selection.

Formatting
- Format column A with dollar signs
  - Select Column A, from the right-click or Home tab, choose the $ format
- Format column B to be centered
  - Select Column B, from the right-click or Home tab, choose Align Center
- Edit Cell C1 (double-click in cell)
  - When you accept, Excel recalculates answer and the format changes
- Format Column C with dollar signs
  - Note format in cell C10, no longer a date

Reformat Date
- Click on Cell C10 (we don't want the whole column)
- Choose \texttt{Short date} from the list of number formats, in the Number group on the Home Tab
- Choose "More Numbers" to view different date formats
- Choose the 14-Mar format to return to the original date formatting
  - To custom build a data format see pg 4

Formula View (pg 5)
- Toggle cell data with ctrl-` (Ctrl-~ ... Wavy line above tab, below Esc)
- We can see all the formulas but NO formatting
- Toggle back to answer view
Create Data Table
- Click on the Plus sign next to Sheet 2 to create Sheet 3
- Zoom to 150%
- Type in the table shown here

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Big City Store</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sales Report</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Items</td>
<td>Price</td>
<td>Qty</td>
</tr>
<tr>
<td>5</td>
<td>A</td>
<td>123</td>
<td>987</td>
</tr>
<tr>
<td>6</td>
<td>BB</td>
<td>456</td>
<td>654</td>
</tr>
<tr>
<td>7</td>
<td>CCC</td>
<td>789</td>
<td>321</td>
</tr>
</tbody>
</table>

Format Data Table
- Bold Row 4
- Center Column C
- AutoFit Column C
- Dollar Format the Prices, B5 through B7
- In Cell D4 type: SubTotal
  - Should be bold already

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Big City Store</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sales Report</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Items</td>
<td>Price</td>
<td>Qty</td>
<td>SubTotal</td>
</tr>
<tr>
<td>5</td>
<td>A</td>
<td>$123.00</td>
<td>987</td>
<td>=B5*C5</td>
</tr>
<tr>
<td>6</td>
<td>BB</td>
<td>$456.00</td>
<td>654</td>
<td>=B6*C6</td>
</tr>
<tr>
<td>7</td>
<td>CCC</td>
<td>$789.00</td>
<td>321</td>
<td>=B7*C7</td>
</tr>
</tbody>
</table>

Calculate SubTotals
- Enter First SubTotal
  - In Cell D5 Type: =B5*C5
    - $121,401.00
- Each total is going to be the price of the item, times the Qty sold of the item. If we had 3,000 records, we would not want to type the equation 3,000 times
  - Our equation is a pattern, "the cell two away, times the cell next to me"
  - Anywhere you copy or fill the equation, the pattern will follow
- Use Fill handle to pull down this "pattern"
- Switch to Formula view (Ctrl ~) to see results and switch back to normal view
Calculate Taxes
- In Cell D2 type: Tax Rate
- In Cell E2 type: 10%
- In Cell E4 type: Taxes
- In Cell E5 type: =D5*E2
  o Our pattern is Subtotal times Tax Rate
- Use fill handle to pull down equation
  o Don't Panic, these answers are supposed to look weird

Absolute vs Relative (pg 6)
- What Happened?
  o Pattern "Cell next to me * Cell three above me"
  o As we move DOWN the pattern continues but it’s wrong for this equation
- Erase the answers
- In Cell E5 type the same equation: =D5*E2
  o Before you accept, press the F4 button on the keyboard to lock cell address E2
  o =D5*$E$2
    ▪ you can type in the $ signs, but F4 is often faster
    ▪ Think FORCE for the F4 button
  o D5 is relative (always cell next to me)
  o $E$2 is absolute (always cell E2)
- Use fill handle to pull down the equation

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Big City Store</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Grand Total</td>
<td>Tax Rate:</td>
<td>10%</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Items</td>
<td>Price</td>
<td>Qty</td>
<td>SubTotal</td>
</tr>
<tr>
<td>5</td>
<td>AAA</td>
<td>$123.00</td>
<td>987</td>
<td>$121,401.00</td>
</tr>
<tr>
<td>6</td>
<td>BB</td>
<td>$456.00</td>
<td>654</td>
<td>$298,224.00</td>
</tr>
<tr>
<td>7</td>
<td>C</td>
<td>$789.00</td>
<td>321</td>
<td>$253,269.00</td>
</tr>
</tbody>
</table>

Calculate Totals
- In Cell F4 type: Total
- In Cell F5 type: = D5+E5
- Use fill handle to pull down the equation
Calculate Grand Total

- In Cell E8 Type: Big City Store Grand Total
  o From the Home tab, Align Right
    ▪ If it won't let you, make sure you have accepted your entry (enter or ✓)
- Click in Cell F8
- Use AutoSum button Sigma - ∑ in the Editing group on far right of the Home tab
  o =SUM(F5:F7)
  o In English, this reads "Calculate the Sum of F5 through F7"

Note: When you click the AutoSum button Excel looks for numbers above the current cell. If it can't find a number, it will look to the left. The AutoSum button has a drop down menu to do quick calculations for Sum, Average, Max, Min, and Count.

Confirm your answer

- Select cells F5:F8
- Look at the status bar in the bottom right of the window to see the Average, Count, and Sum
  o Sum should be $740,183.40

- Change the fill color for cells F5:F8 to yellow
  o These are now our "Yellow Numbers"

Set up for Functions

- In Cell C9 type: Grand Total
- In Cell C10 type: Total Avg
- In Cell C11 type: # of Items
- In Cell C12 type: Largest Sale
- In Cell C13 type: Smallest Sale
- Right align all titles in cells C9:C13
Set up Functions (pg 7)
- Click in cell D10
  - We can tell we are in cell D10 because of the Name Box
- Press the Equal Sign =
  - The Name Box has changed to a list of Most Recently Used Functions
  - Since the last function used on this computer is SUM, it’s listed first

Choose SUM
  - This will open the Function Arguments window
  - Clear the contents in the Number1 box
  - Move window so you can see the yellow numbers
    - To move: click in the title bar or any grey blank space and drag
  - Once you can see the yellow numbers, click in the first one, cell F5
  - Drag to the last yellow number, F7
  - Selection should be F5:F7
  - Click OK
- Sum should be $740,183.40
- Clear Cell D10
Excel 2016 Basics 2 Math and Functions – Class Exercise

**Search for Functions (pg 7)**
- In Cell D10 Type: =
- Open the List of Recent Functions from the Name Box
- Click on the last option, More Functions...
  - If you click on a function name, Excel gives a brief description.
  - Click on the Help on this function link for a Help article about this function, usually with examples.
- Erase the "Type a brief description of what you want to do and then click Go" from the Search box. Type in ADD and click the GO button.
- Select Sum from the list and click OK
- This opens the same Function Arguments window
  - Choose your Yellow Numbers and Click OK
- Sum should be $740,183.40
- Clear Cell D10

**Editing a function (pg 8)**
- Press the Equal Sign
- Choose SUM from function list
- Click OK
  - Answer should be WRONG
  - Why? Because we don’t have the yellow numbers
- Click on the Edit Function box in front of the formula bar
  - This opens the Function Arguments window
- Choose the Yellow Numbers and Click OK

**Other Basic Functions**
- Click in Cell D11
- Press Equal Sign =
- Click on List of Functions
- Choose Average (aka Arithmetic Mean)
- Choose Yellow Numbers and Click OK
- Using Yellow numbers for each
  - In cell D12 calculate the Count
  - In cell D13 calculate the Max
  - In cell D14 calculate the Min
Final Result

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Big City Store</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Grand Total</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Items</td>
</tr>
<tr>
<td>5</td>
<td>AAA</td>
<td>$123.00</td>
<td>987</td>
<td>$121,401.00</td>
<td>$12,140.10</td>
</tr>
<tr>
<td>6</td>
<td>BBB</td>
<td>$456.00</td>
<td>654</td>
<td>$298,224.00</td>
<td>$29,822.40</td>
</tr>
<tr>
<td>7</td>
<td>C</td>
<td>$789.00</td>
<td>321</td>
<td>$253,269.00</td>
<td>$25,326.90</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Big City Store Grand Total</td>
</tr>
</tbody>
</table>

Reset for next lesson

- Clear the calculated taxes, Cells E5:E7
  - Notice how it carries through to all the answers
- Clear the Grand Total in Cell F8
- Clear the five functions you created in Cells D10:D14
- Press Ctrl-Home to return to the top of the worksheet

Naming a Cell (pg 9)

- Click in cell E2 (10%)
- Click in Name box
  - Erase E2 in Name box
  - Type TaxRate
    - No Spaces, No Hyphens, capitalization doesn’t matter
    - Press Enter and TaxRate should still be in the box
- Click anywhere else, see cell address in name box
- Click on E2 (10%), see "TaxRate" in Name Box
- Click anywhere else
- Click arrow next to Name box and choose TaxRate
  - Should jump to cell E2
- Go to Sheet 1, Click on Name box menu, Choose TaxRate
  - Should jump to Worksheet 3, Cell E2
  - We have made a "bookmark" in our workbook

Using named cell in equations

- In Cell E5 type =D5*
- Click on cell E2
  - Instead of E2 we see TaxRate
  - TaxRate is always TaxRate, no ($) locks needed
- Accept and fill down for E6 and E7
Naming Ranges
- Select Yellow numbers
- Type **Total** in the Name box and press Enter

Using named cell in functions
- Click in cell F8
- Use AutoSum button Σ
  - =Sum(Total)
- In Cell D10 type: =
- Choose Sum from the List of Recently Used Functions
- Select your Yellow numbers, you should get Total
- Click OK

Typing in Functions
- Clear cell D10
  - In Cell D10 Type: =SU
    - See list of functions that start with an SU
    - Once you see the word **SUM** Select it
      - Double-click or press Tab (to GRAB!)
    - Continue to type: TO
      - See list of all functions and Names that start with TO
        - Double-click **Total** or tab
        - Press Enter to accept
- Try the same for the other four functions. Type an equal sign, start typing the name of the function. Once you see it, double-click, or tab to grab the selection. Then type the first few letters of total. Double-click or tab to grab. Enter to accept.
  - Cell D11 the Average
  - Cell D12 the Count
  - Cell D13 the Max
  - Cell D14 the Min
- Answers will be the same as the ones on the top of Page 19 of this handout.
Excel 2016 Basics 2 Math and Functions – Class Exercise

Working with Ranges of Data

If we insert new data it must go inside the range

- Insert two rows, one above item "C", one below item "C"
  - Right-click on Row Number 7, INSERT
  - Right-click on Row Number 9, INSERT

- Enter in data
  - In Cell A7 Type: D
  - In Cell B7 Type: 159
  - In Cell C7 Type: 951
  - In Cell A9 Type: E
  - In Cell B9 Type: 357
  - In Cell C9 Type: 753

- Select Cells D5:F5
  - The first SubTotal through the First Total
  - The numbers should not change, just be selected

- Use fill handle to pull down through all the yellow numbers

- Note that the count in cell D12 says there are only 4 Items
Redefining Names

- From the Name box choose "Total"
  - Notice it refers to F5:F8. It included Item C in row 8 because it was inside our previous range, but not item D in row 9.
- Click in an empty cell
- Turn to the Formula tab in the Ribbon
- Look in the Defined Names group for the Name Manager
- Choose Total from list
  - At the bottom of the window erase contents of Refers to:
  - Move window so you can see all the Yellow Numbers
  - Select the Yellow Numbers (=Sheet1!$F$5:$F$9)
- Click the check box at the front of the line to accept
- Click the Close button
  - Click Yes if it prompts you to save

- The Sum of our Total is now over $1,000,000 so our columns widths may be too small.
  - Adjust Column width to read the ####### cells
- The Count (# of Items) of our Total is now 5
Freeze Panes
- Click inside Cell B5
- From the View tab in the Window group, choose Freeze Panes
  - This will lock the first four rows and the first column into place, so as you scroll through the worksheet you can always see the content in those cells.

If Function (if there is time)
- In Cell G4 type: Continue
- Draw Logic Tree
  - If our Total for this item is greater than $250,000, then yes we want to continue
  - If our Total for this item is less than $250,000, then no we don’t want to continue

\[ IF \text{ Item Total} > 250000 \]

- In Cell G5 type: =
  - From the list of functions choose IF and fill in the parts from our logic tree
  - Use fill handle to pull down the equation
  - Edit the function in cell G4 to 280000
  - DON’T FORGET TO: Use fill handle to fill down again